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Single User Edition Minimum Requirements
Windows

Pentium III

OS: Windows 2000, XP & VISTA

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution
Mac OS

G3 or better processor

Mac OS X 10.3 greater

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution
Server Edition Minimum Requirements
Windows

Pentium III

OS: Windows 2000, XP & VISTA

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution

Mac OS

G3 or better processor

Mac OS X 10.3 greater

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution
Web Server Edition Minimum Requirements
Windows

Pentium III

OS: Windows 2000, XP & VISTA

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution
Mac OS

G3 or better processor

Mac OS X 10.3 greater

64MB RAM

(128 Recommended)

14" Monitor with 256 colors

800 X 600 monitor resolution
Installing Full Version for Windows
Download the Landlord Report Windows full version to your desktop:

Please click the following link to start the Landlord Report full version download: http://www.mdansby.com/downloads/LRW.exe

Once the file has finished downloading, open it and press the install button.

It is not necessary to change the install to location, the Landlord Report should be installed on the C drive in the Program Files folder.
If the Landlord Report is not in the Program Files folder on your C drive, the software may not operate properly.
Installing Full Version for Macintos

Download the Landlord Report Macintosh full version to your desktop:

Please click the following link to start the Landlord Report full version download: http://www.mdansby.com/downloads/LRW.dmg

Once the file has finished downloading, the disk image should open on your desktop.

You must copy the Landlord Report X to your Applications folder.

If the Landlord Report is not in the Applications folder, the softwrare may not operate properly.

Installing Update for Windows

Download the Landlord Report Update for Windows to your desktop:

Please click the following link to start the Landlord Report Update for Windows download: http://www.mdansby.net/downloadregistration/U_LRW.exe

Once the file has finished downloading, open it and press the install button.

Its not necessary to change the install to location, the Landlord Report Update should be installed on the C drive in the Program Files folder.
If the Landlord Report is not in the Program Files folder on your C drive, the softwrare may not operate properly.
Also, if the Landlord Report software is not on your C drive in the Program files folder, the update will not install completely.

Installing Update for Macintosh

Download the Landlord Report Update for Macintosh to your desktop:

Please click the following link to start the Landlord Report Update for Windows download: http://www.mdansby.net/downloadregistration/U_LRM.dmg

Once the file has finished downloading, the file will unpack its self and will be placed the Landlord Report file on your desktop.

Move the file named Landlord Report to the Landlord Report X folder inside your Applications folder.

Upgrading to the Server Edition for Windows

Download the Landlord Report Windows Server Update for Windows to your server desktop:

Stop the Landlord Report Server service or stop the Landlord Report Server application.

Once the file has finished downloading, open it and press the install button.

After the installation is complete, start the Landlord Report Server service or Landlord Report Server application.

Upgrading to the Server Edition for Macintosh

Download the Landlord Report Macintosh Server Update for Windows to your server desktop:

Stop the Landlord Report Server service or stop the Landlord Report Server application.

Once the file has finished downloading, open it and press the install button.

After the installation is complete, start the Landlord Report Server service or Landlord Report Server application.

Upgrading to the Web Server Edition for Windows

Download the Landlord Report Windows Web Server Update for Windows to your server desktop:

Stop the Landlord Report Server service or stop the Landlord Report Server application.

Once the file has finished downloading, open it and press the install button.

After the installation is complete, start the Landlord Report Server service or Landlord Report Server application.

Upgrading to the Web Server Edition for Macintosh

Download the Landlord Report Macintosh Web Server Update for Windows to your server desktop:

Stop the Landlord Report Server service or stop the Landlord Report Server application.

Once the file has finished downloading, open it and press the install button.

After the installation is complete, start the Landlord Report Server service or Landlord Report Server application.Starting Landlord Report – Windows.
To start the Landlord Report software, double-click on the Landlord Report icon on your desktop.

The Landlord Report full version installer, placed a Landlord Report icon on your desktop.

Starting Landlord Report – Macintosh

To start the Landlord Report software, double-click on the Landlord Report icon inside the Landlord Report X folder.

For quick access to the Landlord Report, you can place the Landlord Report on your dock.

Landlord Report Interface

The Landlord Report is very easy to use and to navigate to the different areas of the application.

For example, if you want to access Tenant Information, click on Tenants. This true for all areas of the application.

You can use the palette and the menu bar to navigate around the application.

The palette and menu bar displays the key areas of the software.

The following area are available in the Landlord Report Interface:
Tenants - Track Tenant information

Properties - Track Your Properties and or other Peoples Properties

Property Owners - Track Landlords, Property Owners information

AddressBook - Track Contacts & Vendors

Work Order - Track Work Orders

Messages & Issues- Track Messages (From Tenants, Property Owners, Contacts and Vendors)

Warranties - Track Warranties for Equipment, Products, Services and Labor

Parking - Track Parking locations and spaces

Prospecting - Track Properties you are look at buy or managing

Loans - Track Loans & Mortgages

Vehicles - Track Vehicles in your fleet

Calendar - View events on the schedule, such as Rent Due dates for all Tenants.

Schedule - View Events on the Calendars

Reminders - View To Dos and or Things to do

Forms

Finance

Preferences
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Entering Your First Data

Please use the following steps to get started entering data into the Landlord Report:
Enter your owner information in the Preferences area.

Place your owners information in the Preferences area; name, address, telephone and all fields in red.

Press Save to save the Preferences information

Go to Property Owners and enter your owners there. (If you are managing other peoples properties, enter their information here too)

To add a new Property Owner, press new owner button, this will take you to a blank Property Owner screen.
Go to the Properties, and setup your properties and units.

Setup all your Properties and Units, if you have trouble understanding, please look at the sample data.

To add a new Property, press the New Property button; this will take you to a blank Property screen.

Go to the Tenants area, and setup your tenants.
To add a new Tenant, press the New Tenant button; this will take you to a blank Tenant screen.
There is a pull down option on the General tab that will link a tenant to a property address.

Enter your tenants and the information on the general tab inside tenants.

You can delete sample tenants by pressing the delete button at the bottom.

Registering the Landlord Report

To register the Landlord Report, click on the Unlock Landlord Report button on the Registration Window

or, go to the Preferences area to the Registration tab.

The Preferences area can be found under the View menu item.

Once you get to the Preferences area, Registration tab, enter your information on the left side. Fill in all fields in red.

Make sure you fill in your Company Name, Your Name, Address, City, State, Postal Code, Telephone, Email and how you heard about the Landlord Report. Then, enter your account number and press the activate account button.

If you incounter trouble with the registration process contact support via the Support Portal.

Renewing for Technical Support & Updates

Single User Edition - 
(Updates & Support - 1 Year Extension)
Server Edition - Web & Server Edition-

(Updates & Support - 1 Year Extension) 

Preferences: Entering Your Information
In the Preferences area, there is a button called "Show Banner on Reports".

If this button is checked, the Graphic Banner will be displayed on reports.

If this button is not checked, then the regular company name or

organizational name will be displayed.
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You can create a banner in your paint program or Photoshop application.

The banner must be 600x100.

Show Print Preview - If checked, a print preview will always be displayed.                                                    
---------------------------------------------------> Fonts: <-------------------------------------------------
The font cannot be changed on the Statement and Invoices. But, you can change the fonts for the notices, agreement and letters. Just go to the Tenants, notices tab. You can create and edit all the forms there. 
Printing

Show Print Settings - If checked, the print setting option will be shown every time you print.
Posting assign automatic charges for the following charges:
Automatic Charges
Rent

Rent plus 1 month - this charges next months rent.
Rent #2

Late Fee #1

Late Fee #2

Late Fee #3

Rental Increase

Gas Fee

Water Fee

Cable Fee

Parking Fee

Electric Fee

Sewer Fee

Garbage Fee

Custom Fee #1

Custom Fee #2

Loan Due

Loan Late Fee

The charges checked are automatically charges to the Tenant every month or every billing period. 
Automatic Data Integration 
Flow Tenant Information to AddressBook

Flow Payments / Tenant Payments to Finance

Flow Expenses / Work Orders to Finance

Automatic Printing
Print Late Notice

Print Eviction Notice

Tax on Tenant Charges
Tax on Finance Charges

Preferences: Formats

Set the formats for Telephone, Postal Code, SS Number, ID Number, I Number, N Number, and Bank Routing Number
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Preferences: Custom (Custom Fields)

Two custom fields for Tenants are available. Enter the field label and the label will appear in the Tenant area.

Preferences: Email Settings

To send an email from the Landlord Report, the email settings tab needs to filled in with correct SMTP information.
Enter the return email address and SMTP address.
The return email address is the email address recepentants can reply to and respond to.
The SMTP address is the server address of your SMTP server, The SMTP server sends and delivers email.

If there is no authorization needed to send email, please lease SMTP User Name and SMTP Password empty.

[image: image4.png]SMTP Emall Settngs

Retum Bl Addes

ST Adias:

ST Usar Name:

R g —

Test Bl Connection

|

Ifthere is no authorization needed to send email, please.
leave STMP User Name and SHITP Password empty.




Preferences: FTP Settings

FTP Settings is for the Web Statements Module.
The Web Statement Module automatically places Tenant & Property Owner reports on a server, so Tenants and Property Owners can access those reports. The reports are real time, the most current information on the account. Any changes that occur on the account are reflected on the reports.

The FTP Settings consist of the following:
Hostname
Username
Password
Initial FTP Folder
URL (Website)
Once you have entered your settings, you can test the connection by pressing the Test FTP Connection button.

Preferences: Splash Screen

The splash screen is the screen that opens in the center, when the software first opens.

By Default, the splash screen consists of a picture of an apartment building with blue sky.

This splash screen can be change to any picture you import into the software.
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Preferences: Drop Down Lists 

To edit drop down lists, go to the Preferences area to the Drop Down List tab.

Once you select the list you wish to edit, you can add, modify, delete, and sort elements in the list.

Always press "Save List", after you have made a list modification.

After you have upgraded the software, you can press the "Restore List" to restore your saved list.
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Preferences: Display & Print Settings

Show Print Preview - If checked, a print preview will always be displayed before Printing

Show Print Settings - If checked, the print setting option will be shown every time you print.
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Preferences: Logo/Letterhead

In the Preferences area, there is a button called "Show Banner on Reports".
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If this button is checked, the Graphic Banner will be displayed on reports.

If this button is not checked, then the regular company name or

organizational name will be displayed.

You can create a banner in your paint program or Photoshop application.

The banner must be 600x100.

<-------------------------------------------------> Fonts: <------------------------------------------------->
The Landlord Report will be able to handle the following image types: pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of  images. http://www.apple.com/quicktime/download/
If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

Preferences: Show Text Information Vs. Show Banner on Reports



You are able to add as many users as you wish to the system.
You are also able to grant them access to be able to View records, Create records, Edit records, Delete records, and Print records.
You are also able to grant them access to the different areas of the Landlord Report software.
In the login screen, only the following names should be displayed by default:
Administrator Guest_BlankPassword

A) Login as the administrator (password is admin)

B) Click on the Preferences icon on the palette

C) Then, Click on the Edit Users button

D) Highlight the user named John Doe

E) Go to the password menu item and select Edit User

F) You should be able to change the users name and password here

G) Only change the name and password, nothing else

Do not rename the administrator user.

If you have created/saved your own Password/User List.

Please use the following steps to save your User & Password Settings:

A) Go to the Preferences area and press the Edit Users button

B) Then, go to the Passwords menu item and select Save Groups.

C) Name and Save the file.

D) Install the upgrade

E) Then, go back to Preferences/Edit Users and load your user file.

You must assign users to groups.

Just drag and drop users on the groups you want the user to have access to.

If you do not assign users to groups, then the user will not have access to those areas of the programs. So, Just drag and drop users on the groups you want the user to have access to.

You can not delete users, you can only rename them.
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Preferences: License & Version

The software version can be viewed in the Preferences windows on the upper right hand corner.

The version number always start with the letter v, for an example v20081001.
The version number determines when the software was built and released.

Property Owner: Entering New Property Owner Information

Under the view menu item, there is an option called Property Owners.

Create a new owner and enter all the information including the active

setting.

The property in the list will be added to the property owners pull down

option in properties. Once you add the owners name to the property, it

will appear in the Tenants area with the property address.
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Property Owner: Creating Finance Account for Property Owner

To create a Finance account for a property owner, press the button for create finance account inside the Property Owner record.

This button can be found near the top of the window.

Once you press this button, an account will be automatically created with the Property Owners name as the Finance account name.

If an account already exists, you will get an error message stating the account already exists.

Property Owner: Managing Forms

Inside the Property Owners area, under the Forms tab you can edit notices, forms

and agreements. You can create your own or import existing forms and

agreements.
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On the left side, all your form, notices and agreement will appear. Just

double click on one to edit. On the right side, forms, notices and

agreements specifically for that Property Owner will appear.

To insert the Property Owners name or Address,

Just click on the Insert menu item and select 4D Expression

Choose Property Owner and then Full Name and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your Property Owners.

Click here for the 4D Write User Reference Manual
Property Owner: Generating Reports 

To generate reports, go to the Reports tab within the Property Owners area.

Also you can generate a cash flow report, within the Property Owners Finance account.

Property Owner: Status

If the active check box is checked, the Property Owner is active.

If the active check box is not checked, the Property Owner is not active.

Properties: Create New Property

On the Properties listing screen, press the new property button to add a new property.
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Properties: Create New Property - Single Family Home

Single family house, should have at least one unit, under units tab.
A 4 family building, should have 4 units under the units tab

A 6 family building, should have 6 units under the units tab
Each property that you own or manage should have the corresponding units assigned to them.

After you check the properties area, go back to the tenants area (General tab) and check the rental address pull down option. All your properties & units should appear in the pull down option.

Select the right unit the tenant is renting or leasing.

T = Total Units O = Occupied V = Vacant

Go into the Properties area. You will see the Property listing screen, that show all the properties.

If you double click on a property, you will see the detail information on that property. When you first go in to t his area, it will take you to the units tab.

The units tabs shows all the units corresponding to the property.

To add a unit hit the "plus" on the left side. To delete a unit hit the "minus" on the left  side.

After you hit the "plus" symbol to add a unit enter the following information: A) Enter the apartment / unit number B) Enter the apartment or unit - floor level C) Enter the number of Bedrooms / Rooms ) Enter the markert rent for the unit E) Enter the square footage for the unit.
The tenants name and rented check box will automatically fill in when you link a Tenant to the unit in the Tenants area (General Tab).

You should go to properties to add new properties or to remore properties that you own or manage.

Properties: Create New Property - Multi Unit Building

SPECIAL NOTE - TRAILER PARKS (MOBILE HOME PARKS)
Each mobile home should be a separate unit. Just enter each mobile home and the unit# should be the mobile home number. The number of units you have should, be the same number as the number of mobile homes in the park. The property address should be the address of the mobile home park. The Tenants name and lease expiration will automatically fill in when you link a Tenant to the unit. The Tenants name, rented check box, and lease expiration is non enterable.

Properties: Associating a Property Owner to a Property

Under the view menu item, there is an option called Property Owners.

Create a new owner and enter all the information including the active

setting.
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The property in the list will be added to the property owners pull down

option in properties. Once you add the owners name to the property, it

will appear in the Tenants area with the Property address.

Properties: Searching

On the properties listing screen, you can search properties by pressing the search button.
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Properties: Sorting

On the properties listing screen, you can sort properties by pressing the sort button. 
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Properties: Printing

You can find reports for properties under the Report menu item and also inside the Properties area.

Properties: Property Status

If the active check box is checked, then the property is active.

If the active check box is not checked, then the property is not active.

Properties: Delete Property 

On the input screen, the delete button is on the bottom of the screen.

Tenants: Add Tenant

To create a new record, go to the area in which you want to create a new record.

Then press the new button, a new blank record will appear were you can insert your data.

For an example, Go to the Tenants area, then press the "New Tenant" button.
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Tenants: Setup Tenant

To setup your Tenants, go to the Tenants area (General Tab).

Click on the Tenants icon on the Palette

Click the New Tenant button on the bottom of the window

Enter the Tenants name, then go to the general tab or the first tab.

Assign the rental status to renting.

An active Tenant is renting or leasing, So the Tenant status for an active Tenant should be "Renting" or "Leasing"

Special Note: If the status is renting or leasing, the Tenant is active. It does not matter if you post the rent due date.
Select the address and the Tenants who are going to be renting. Fill in the Rent and Late Fee amounts. Enter the Rent Due Date and the Late Charge Date. The dates work like the following; if the rent due is July 2, 2004, rent is due on the 2nd of every month. Example - 07/02/2004 = Rent is due on the second of every month. Day number is the day the rent is due. The application will automatically charge each Tenant the appropriate charges every month. The only thing you need to do is enter any payments they make, and extra charges, for example, damage. Rent status of renting or leasing is an active Tenant. The application will consider them active Tenants. Any status other than renting or leasing is not an active Tenant. So, make sure the following is filled in on the general tab 1). Rent Status (Renting / Leasing 2) Rent Amount 3) Late Fee Amount 4) Rent Due Date (Day number is important) 5) Late Fee Date (Day number is important) All Tenants are active while their rent status is Renting or Leasing. So, if your Tenant moves, then change the status to Moved Out.

* * * * * * * * * * * * * * * * * * *Weekly, Bi-Monthly & Annual Rentals* * * * * * * * * * * * * * * * * * 
If you need to setup a week or bi-monthly rental. Please use the following instructions:
Go to the Tenants, general tab. Select Day Interval and enter 7 for days - This will charge the Tenant a weekly rent.
Select Day Interval and enter 15 for days - This will charge the Tenant a twice a month for rent.
Select Day Interval and enter 365 for days - This will charge the Tenant a once a year for rent.
Tenants: Selecting Property Address

To select a property address for the Tenant, from the Property Address pull down select your desired rental address.

Tenants: Selecting Finance Account

To select a finance account, go to the payment tab and choose a Finance account from the Finance account pull down option.

Once selected, all payments recorded will flow into the choosen Finance account.
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Tenants: Tabbed Panels

The tabbed panels lets you navigate around the window to the different sections of the record.

The tabbed panels are in the Tenants area:
General

General 2

Payments

Telephone/Email

Employment

References

Occupants/Pets

Vehicles

Legal Actions

Forms

Photos

Photos 2

Photos 3

Comments

Notes

Messages

Work Orders

Documents

Sign Documents

Report

Loans

Loans2

Loans 3

Financial
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Tenants: Automatic Postings (Rent & Late Fees)

Fill in all the dates you wish to keep track of. When you add a rent

charge, the day number will be take and assigned to the current month.

Sample: 01/01/2002

The rent will be due on the 1st of each month.

Single family house, should have at least one unit, under units tab.

Multifamily building, should have multiple units under the units tab

After you check the properties area, go back to the tenants area (General

tab) and check the rental address pull down option. All your properties &

units should appear in the pull down option.

Select the right unit the tenant is renting or leasing.

Tenants: Add Payment

On the payments tab, is where you enter payments or charges for your Tenants.

To enter a charge, press the add charge button.

To enter a payment, press the add payment button.

The application will automatically add all charges for you each month, see the automatic posting area so more information.

All you have to do is to enter payments your Tenants make to you.
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Each transaction must be separated.

The payments should be entered as the following:

10/01/2003 Rent Due $660 Balance Due $660

10/01/2003 Paid $100 Balance Due $560

Each transaction must be separated, payments and charges should not be on

the same line.
The rent due must be spelled out “Rent Due”, You can name it anything, but include the name “Rent Due” So you can have “Rent Due – SSI” or “Rent Due – Section 8”.
Special Note: If the status is renting or leasing, the Tenant is active. It does not matter if you post date the rent due date.

Delete the line and re enter on two separate lines / transactions. Special Note: S8 = Section 8, GA = General Assistance, SH = Subsidize housing, Add rent + 1 = add next months rent Add, nsf = non-sufficient funds, add bad check fee You can add two custom fees in the Preferences area and Tenants General Tab.

NON SUFFICIENT FUNDS - HOW TO RELECT IN STATEMENT
Please do the following to reflect NSF -Non Sufficient Funds: In the Preferences area, there is a field that holds the amount you charge for NSF. Enter your amount there and press save. Then go to the Tenants area, to the Tenant record. Press the NSF button to charge them for the bad check. Then reenter the rent charge again manually. That way they can see the first payment that was bad and the fee that you charged them. And the Rent Amount still owingSAMPLE BELOW  01/01/2005 Rent Due $500 Balance due $500 01/02/2005 Paid $500 Balance due $0 01/11/2005 NSF $30 Balance due $30 01/11/2005 Rent Due $500 Balance due $530
Tenants: Add Charge

To add charge for a Tenant, press the Add Charge button

This will take you to the Transaction screen.

Enter date, description of the charge and amount. Then press save to record the charge transaction.

[image: image20.png]’Transaction (Charge)

Date: [07/22/08 =

Description: | Misc Fee

amountowss: [i000 @





Tenants: Add Late Fee

There are three different types of late fees:

The first two Late Fees operate independent of each other.

You can set the dates you want Late Fee #1 and Late Fee #2 to occur. You can set one or both. Its all up to you and how you manage your Tenants. The check boxes next to the fee has to checked to operate the Late fees. If the boxes are not checked, then the fee will not be charged. Each Tenant can be setup independent of each other.

A) Late Fee #1

B) Late Fee #2

C) Daily Late Fee

Late Fee #1 is the first and original late fee.

You can assign the date for Late Fee #1 by entering the date in Late Fee Date #1.

Late Fee #2 is the second late fee. You can assign the date for Late Fee #2 by entering the date in Late Fee Date #2.

The Daily Late Fee operates, the day after the first late fee, it also operates on the Late Fee Date #1.

The Late Fee dates work like the following, if the Late Fee due is July 5, 2004.

The Rent will be late on the 5th of every month.

Example - 07/05/2004 & Balance greater than zero = Late Fee Charge.

You can uncheck the check box for late fee and they won’t reappear. If you go to the Preferences area, posting tab and check reactivate late fees. Next month the late fee check box that you unchecked will be checked and reactivated.

Tenants: Print Tenant Statement / Invoice

To print Tenant Statement, go to the Tenant record you want to print.

Once you get to the Tenant record, press the Print Tenant Statement button to print the statement.

Tenants: Managing Tenant Forms

Inside the Tenants area, under the Forms tab you can edit notices, forms

and agreements. You can create your own or import existing forms and

agreements.
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On the left side, all your form, notices and agreement will appear. Just

double click on one to edit. On the right side, forms, notices and

agreements specifically for that Tenant will appear.

To insert the Tenant name or Rental Address,

Just click on the Insert menu item and select 4D Expression

Choose Tenants and then Tenants Full Name and and Rental Address.

You can also right click in the word processing window to insert application fields.

Creating a Late Notice = Create the Late Notice and check the late notice check box.

Creating a Eviction Notice = Create the Eviction Notice and check the evication check box.

You only have to create the form once, and you can use them with all of your Tenants.

Click here for the 4D Write User Reference Manual
Tenants: Searching

On the Tenant list screen, which shows a list of your Tenants with there status, rent and balance due amounts.

You can search for Tenants on this screen, by press the search button or quick search button.
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Tenants: Sorting

On the Tenant list screen, which shows a list of your Tenants with there status, rent and balance due amounts.

You can sort by pressing the sort button.
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Tenants: Printing

Print options can be found in the Tenant record and the Report tab inside the Tenant Record.

Tenants: Printing Labels

To design the labels:

1 Click the Label tab to go back to the Label design page.

2 Drag the field Tenant Full Name so that it is positioned near the top of the

label in the label design area.

3 Drag the field Rental Address to the label.

4 Drag the field Rental City, Rental StateProvince and Rental ZipCode PostalCode to the label.

5 Choose Select All in the Edit menu.

6 Click the Align Left icon.

7 Choose Times in the Font pop up menu.

8 Click Left in the Justification pop-up menu.

Click the label editor, its the button that says labels or the icon that looks like an envelope. After the label editor is open you can drag the item to build the label. The bar code field is called "BarCode Image". You can save your label template for use in the future. So, just save and load later.
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Tenants: Tenant Status

The Tenant Status determines if the Tenant is active or not active.

If the Tenant Status is Renting or Leasing, the Tenant is active.

And the software will automatically charge the Tenant rent every month on the due date.

If the Tenant Statis is not Renting or Leasing, the Tenant is not active.

No automatic charges will be applied if the status is not active.

Tenants: Save Tenant

To save a record, press the "Save" button, and the record will be saved.

Tenants: Delete Tenant

To delete a record, go to the record you wish to delete and double-click it.

Then press the "Delete" button, the delete button will delete the current record.

For an example, Go to the Tenants area, Select the Tenant you wish to delete, then press the "Delete" button.

You can only delete one record at a time.

Address Book: Add Contact / Vendor

On the listing screen, press the New AddressBook button to add a new record.

Address Book: Tabbed Panels

The tabbed panels lets you navigate around the window to the different sections of the record.

The tabbed panels are in the AddressBook:
General

Comments

Notes

Account Numbers

Forms
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Address Book: Managing Contacts / Vendor Forms

Inside the AddressBook area, under the Forms tab you can edit notices, forms

and agreements. You can create your own or import existing forms and

agreements.
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On the left side, all your form, notices and agreement will appear. Just

double click on one to edit. On the right side, forms, notices and

agreements specifically for that Property Owner will appear.

To insert the AddressBook name or Address,

Just click on the Insert menu item and select 4D Expression

Choose Property Owner and then Full Name and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your AddressBook.

Click here for the 4D Write User Reference Manual
Address Book: Searching

To search for AddressBook record, press the search button on the AddressBook listing screen.
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Address Book: Sorting

To sort your AddressBook records, press the sort button on the AddressBook listing screen.
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Address Book: Printing

To print AddressBook records, press the quick report button on the AddressBook listing screen.

This will allow you to select fields to print. The selection will be printed.

Address Book: Printing Labels

To print labels for your AddressBook records, press the labels button on the AddressBook listing screen.

The label button will open the label editor, the label editior allows you to create, design and save labels for printing.
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Address Book: Delete Contact / Vendor

On the input screen, the delete button is on the bottom of the screen.

Finance: Create Account

On the listing screen, press the New Account button to add a new record.

Finance: Adding Transactions

On the blank record, enter your date, description, category, memo and amount.

Then press the save / record button to save the transaction.

Finance: Linking Property Address to Transaction

Select the transaction, then press the link property address button.

Finance: Editing Transaction

Select your desired transaction, and click inside the field in which you want to edit.

Edit the field and then press save record / transaction at the bottom.

Finance: Delete Transaction

On the finance screen, the delete transaction button is on the left side of the screen.

Finance: Search Transaction

You can search transactions by Date, Payee, Description, Category, Memo and Property Address.

Once you search for the transaction, you can print the register. If you want to restore the account transaction to the full listing, press the refresh button.
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Finance: Print Register / Cash Flow Report

To print the register, press the print register button

To print the cash flow report, press the cash flow report.

Finance: Print Checks

You can use magnetic ink to print 100% legal checks on totally blank check stock.

Simply insert the blank check stock into your printer tray, and print your checks.

Press the design check button to design your checks. Press the print check button to print your checks.

---------------------------------------------------

To design your check, go to the View menu item and scroll down to Edit user forms, then click on User_Check. The default check template will be loaded.

You need the following fields.

Date

Check Number

Payee & Description

Memo

Check Amount

Check Text Amount

Once you have designed your check, save the default check template.
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Forms: Add Form

The font can not be changed on the Statement and Invoices.

But, you can change the fonts for the notices, agreement and letters.

Just go to the Tenants, notices tab. You can create, edit all the forms there.

Forms: Printing Forms

To print forms, press the print form button. This will open a window that will allow you to select the Form to print.

Forms: Emailing Forms

To email forms, press the email form button. This will open a window that will allow you to select the Form to email.

Forms: Import Form

To import a document, open your form and press the import document button on the bottom.

When import documents, you may lose some formating. Text and pictures can be imported together. If you have pictures, copy and paste your pictures or photo in after you placed the text.

Forms: Export Form / Save Form

To export a form, open your form and press the save document button on the bottom. You will be able to save your document in any format you wish. You choose the location to save the document.

Forms: Placing Tenant Fields on Form

To insert the Tenant name or Address,

Just click on the Insert menu item and select 4D Expression

Choose Tenant and then Name Full Name and Rental Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your Tenants.

Forms: Placing Address Book Fields on Form

To insert the Contact name or Address,

Just click on the Insert menu item and select 4D Expression.
Choose AddressBook and then Name Full Name and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your AddressBook.

Forms: Placing Property Owner Fields on Form

To insert the Property Owner name or Address,

Just click on the Insert menu item and select 4D Expression.
Choose Tenant and then Name Full Name and Address.

You can also right click in the word processing window to insert application fields.

You only have to create the form once, and you can use them with all of your Property Owners.

Forms: Delete Form

To delete a form, press the delete button on the Form screen.

Work Order: New Work Order

On the listing screen, press the New Work Order button to add a new record.

Work Order: Work Order Status

If the Work Order status is open, then the work order is active.

If the Work Order status is closed, then the work order is not active.

The following status is available for Work Orders:
Open
Completed
Closed
Canceled
Consulting
Hold
In Progress
Repetitive
Research
Started

Work Order: Assigning Responsibilty for Work Orders
The party responsible for the work order pays for the work being performed.

The following parties can be responsible for the work order:
Self
Work Location
Vendor / Issued to Person

Work Order: Assign Work Order to Finance Account

To select a finance account, go to the payment tab and choose a Finance account from the Finance account pull down option.

Once selected, all payments recorded will flow into the choosen Finance account.

Work Order: Delete Work Order

On the input screen, the delete button is on the bottom of the screen.

Work Order: Search Work Order

To search for Work Order record, press the search button on the Work Order listing screen.
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Work Order: Quick Report

To build the report:
1) Double-click the field Tenant Full Name in the Select the fields area. 2) While the column is still highlighted, click the Sorted check box. 3) Double-click the following fields to add them to your report: Address, City, StateProvince, ZipCodePostalCode. As you double-click each column, it is added to your report. Your report now looks like this: 4) Click the Scroll Bar right arrow or expand the window so you can see the column Cost. The Cost column should already be highlighted. If it is not, click at the top of the column to highlight it. 5) Click the Sum button in the Cell Summary area.
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Work Order: New Work Order
On the listing screen, press the New Work Order button to add a new record.

Messages: Add Message
On the listing screen, press the New Message button to add a new record.

Once you create a message, the status is open by default.

If the status is not open, then the status is not active

Messages: Assigning Repair Fix Status

If the repair fix check box is checked, then you can create a work order based the information from the message.

Messages: Delete Message

On the input screen, the delete button is on the bottom of the screen.

Messages: Print Message

The Messages List can be printed and the individual message can be printed.

The print button is on the bottom of the screen.

Parking: Add Parking Location

On the listing screen, press the New Parking button to add a new record.

Parking: Add Parking Space

On the Parking screen, press the New Parking Space button to add a new space. 

Parking: Delete Parking Location

On the input screen, the delete button is on the bottom of the screen.

Parking: Delete Parking Space

On the input screen, the delete button is on the bottom of the screen.

Calendar: Viewing Dated Eventsc

View important dates for Rent Due, Messages, Work Orders, Tenant Actions, Tenant Balances, and Birthdays.
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Schedule: Creating Events

To create an Event record, the user can position the mouse pointer within the Schedule area and then point, click and drag a rectangle within the date (or resource) and time area desired. If you wish to create an event record/object (physically) on top of an existing Event/object, you must depress and hold the option key down and then perform the point-click & drag operation.

Schedule: Moving Events

To move an Event record, the user can point, select and drag an object to another cell within the Schedule area. Dragging between non-timed Banner events and regular events and vice versa is not permitted.

Schedule: Resizing Events

To resize an Event record, the user must position the mouse pointer at the bottom of the Event object. Once the cursor changes to the cross-heir status, the use can click on the bottom of the object and drag it downward to establish a new end time. Whether creating or moving and object, it is only possible to create an end-time which corresponds to the currently shown interval. As a developer, either provide an Schedule: tool which allows end-user to alter the time intervals shown or provide direct access to an input dialog or form for editing.

Schedule: Coloring Events

To change the color of an Event/object, the user can control-click on an event/object which then automatically displays the Color palette pop-up. The User can then drag the mouse pointer to the desired color cell and release the mouse to select that color. To cancel the color pop-up, the User can simply drag off of the palette.

Schedule: Tabbing

Schedule manages and maintains a list of selected cells throughout an application session. By depressing the Tab key the User can Tab between the events most recently edited. Alternatively, by depressing the Shift and Tab keys concurrently, the User can tab among these events in reverse order.

Schedule: Calendar Navigation

When the area is displayed to the user, they may select any date in the currently displayed month simply by clicking on it. The calendar will always have exactly one date selected. The user may scroll to the next or previous month by clicking on the arrow buttons in the upper-right or upper left corner of the area. If the user holds down the Command key when clicking on these buttons, the calendar will scroll to the next or previous year.

Scrolling the calendar does not change the selected date - the user must click on a date cell in order to do so. If the currently selected date is in a month other than the one currently displayed in the area, the user may "jump" to the month of the currently selected date by clicking on the title-bar

Schedule: Delete Event

Deleting Events/Objects

To delete an Event record, the user can select an event object within the Schedule area, then press Control-Delete (Windows) or Command-Delete (Macintosh).
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Loans: Add Loan

On the listing screen, press the New Loan button to add a new loan. You will have to enter loan amount, and the terms.

Loans: Delete Loan

On the input screen, the delete button is on the bottom of the screen.
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Vehicles: Add Vehicle

On the listing screen, press the New Vehicle button to add a new record.

Vehicles: Delete Vehicle

On the input screen, the delete button is on the bottom of the screen.
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Prospecting: Add Prospecting

On the listing screen, press the New Prospect button to add a new record.

Prospecting: Delete Prospecting

On the input screen, the delete button is on the bottom of the screen.
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Reports: Generating Reports

Most of the Reports are located in two places.

1) Under the Reports - menu item at the top of the screen. 2) Inside each module - at the bottom of the screen Sample: Tenants, print tenant statement and print tenant invoice.

Rental Income Report: The information comes from Tenant payments collected
Rental Charges Report: The information comes from Tenant charges posted.
Rental Expenses Report: The information come from Finance expenditures.

Reports: Generating Reports with Print Preview

Upon selecting a printing option, after the page setup screen.

The page setting screen will appear, this window contains a print preview check box.

If the print preview check box is checked, then you will get a print preview on screen.

You will have an option to actually print the print prewiew screen.

Pictures: Importing Pictures

The Landlord Report will be able to handle the following image types:

pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Pictures: Viewing Pictures

You can view pictures on the photos tab. The photos tab will show all your photos.

Pictures: Problems Importing Pictures

The Landlord Report will be able to handle the following image types:

pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of images.

http://www.apple.com/quicktime/download/
If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

Pictures: Can't Import Pictures

The Landlord Report will be able to handle the following image types:

pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps.

Download the free QuickTime player, this plug-in will help process more types of images.

http://www.apple.com/quicktime/download/
If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

Data: Importing Data

To Import Data, go to the File menu item and select Import Data

You can import contact information only. Name, address, city, state, zip and telephone numbers. Just select the option to import data under the file menu item.
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To import the text file into the Landlord Report:
1 Choose Import Data… in the File menu.

The operating system’s standard Open File dialog appears. If you are not already in the directory, locate your file, the file must be text file (.txt) Note: These dialog boxes may vary depending on the version of your Operating System

Importing Records into the Tenants or Address Book areas

2 Double-click the file to open it.
The 4D Import Wizard appears, showing you the contents of the import file. If necessary, you can align the columns with the file import file with the fields in your database.

The Import Wizard assumes that the data in your import file is in the same order as the fields in your database. However, if some of the field choices are not correct, you can select a different field to import a column into it by choosing a field from the pop-up menu at the top of that column.

For additional information, and for help with specific importing challenges, see the 4th Dimension User Reference Manual.

3 Click the Import button.
4D returns to the [AddressBook] Output form, which displays the 20 records that you just imported. Note that the top of the window now says “AddressBook: 20 of 21,” which means that you now have a total of 21 records in your database.

Selected table Field associated to each column Contents of the import file

Data: Exporting Data

To Export Data, go to the File menu item and select Export Data
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Data: Copy Data File

Under the File menu item, Select Copy Data File.

This option will allow you to copy the current data file to the location of your choosing.
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Data: Backup Data (Manually)

Windows: Just save all of the contents of the Landlord Report folder in your Program Files folder on the C Drive. Macintosh: Just save the all of the contents inside the Landlord Report folder. You can copy this folder to another drive or burn the folder to a CD. Your data is stored in the file named LandlordReport.data. You can rename the data file if you wish (YourName.data).

We recommend that you backup the Landlord Report to a CD blank once a month.

Just drag and drop the Landlord Report folder on to your CD-RW drive and create a backup.

Data: Backup Data (Local)

Select Backup – Local under the File menu item.

Press the Preferences button when the backup process window opens.

Go to Backup, select schedule, select one week or month.

Go to backup and select the destination of the backup.

Go to Restore and make sure all three check boxes are checked.
DO NOT BACKUP MORE THAN ONCE A WEEK.

WE RECOMMEND ONCE A MONTH.

Data: Backup Data (Online)

If you order the online backup or offsite backup (backup module),

go to the Preferences area and select the day of backup.

Go to the Preferences area and select the day of the week, the application will upload

your data to the Backup Server once a week.

If you need to recover your data just send an email to support@mdansby.com,

Support will repley with a link to download the most recent

backup copy of your data file.

Data: Move to a New Computer

Windows: Please use the following steps to move your Landlord Report data to a new computer:

1. Go to the C drive / Program Files / aLandlordReport folder / Database folder

2. Copy / Burn to a CD the file named "LandlordReport.4DD"

3. On the new computer, download the Landlord Report trial from our website.

4. Install the Landlord Report Trial version

5. After installation, copy the file on your CD to the Landlord Report folder.

6. Your data is now in place. You can start the Landlord Report on the new computer.

Macintosh: Please use the following steps to move your Landlord Report data to a new computer: 1. Go to the C drive / Program Files / Landlord Report folder 2. Copy / Burn to a CD the file named "LandlordReport.data" 3. On the new computer, download the Landlord Report trial from our website. 4. Install the Landlord Report Trial version 5. After installation, copy the file on your CD to the Landlord Report folder. 6. Your data is now in place. You can start the Landlord Report on the new computer.

Data: Generate Quick Report

To build the report:
1) Double-click the field Tenant Full Name in the Select the fields area. 2) While the column is still highlighted, click the Sorted check box. 3) Double-click the following fields to add them to your report: Rental Address, Rental City, Rental State Province, Rental ZipCode/PostalCode, Current Balance Due. As you double-click each column it is added to your report. 4) Click the Scroll Bar right arrow or expand the window so you can see the column Current Balance Due. The Current Balance Due column should already be highlighted. If it is not, click at the top of the column to highlight it. 5) Click the Sum button in the Cell Summary area.

Data: Data Recovery

Data Recovery Instructions

Data: Interruption has occurred

Interruption has occured - Restore Instructions

Windows & Displays: Close Windows / Close Box

To close any window, press the "Cancel" or "Done" button in the lower left hand corner of the window.

You can also close a window by pressing the close box

Messages & Notifications: Error Messages

--------------------------------------->

ERROR MESSAGE #9939

--------------------------------------->

Please use the following steps to correct an Error Message #9939:

A) Go to the Landlord Report Folder in your C drive / Program Files

folder. View window by Details and sort by Type.

B) Copy the file named "LandlordReport" with the file type "4D Data File"

to you desktop.

C) Go to your control panels and uninstall the Landlord Report application.

D) Download the Landlord Report - Trial Version and save to your desktop

Windows Version.
<http://mdansby.com/downloads/LRW.exe>
http://mdansby.com/downloads/LRW.exe
Macintosh Version

<http://mdansby.com/downloads/LRM.dmg>
http://mdansby.com/downloads/LRM.dmg
E) Install the Landlord Report and hit cancel in the password dialog window.

F) Place the "LandlordReport" with the file type "4D Data File" on your

desktop to the LandlordReport folder. This folder is on your C drive in

the Program Files folder. It will ask to replace the file, select yes.

Start the Landlord Report now.

Messages & Notifications: Update Available Notifications

When an new update is available, the software will notify you with a pop up message.

Once you see the pop up message, you will then be allowed to download and install the update.

Updates are usually released every 3-5 months.

Mobile Module: Palm

The Palm / PocketPC Module allows you to carry your data with you. Sync Tenants and AddressBook information with Microsoft's Outlook and Apple's Address Book and iCal.

The data can be synced both ways, to and from the mobile device to your desktop computer.

The Palm/PocketPC Module works with Microsoft Outlook 2003 or greater and Apple's AddressBook and iCal for OSX.
Windows Users: To start syncing, click on the Microsoft Outlook Icon in the Tenants, Address Book areas.

Macintosh Users: To start syncing, click on the Apple AddressBook / iCal Icon in the Tenants, Address Book areas.

Mobile Module: PocketPC

The Palm / PocketPC Module allows you to carry your data with you. Sync Tenants and AddressBook information with Microsoft's Outlook and Apple's Address Book and iCal.

The data can be synced both ways, to and from the mobile device to your desktop computer.

The Palm/PocketPC Module works with Microsoft Outlook 2003 or greater, and Apple's AddressBook and iCal for OSX.

Windows Users: To start syncing, click on the Microsoft Outlook Icon in the Tenants, Address Book areas.

Macintosh Users: To start syncing, click on the Apple AddressBook / iCal Icon in the Tenants, Address Book areas.

Contact Support: Emailing Support

You can contact support at support@mdansby.com
Screen shots help describe and show issues or problems. In cases where you can provide a screen shot, please do. It helps resolve the issue faster. Please send screen shots and a short description to support@mdansby.com via email or by fax to 001-646-219-2818.

Screen shots help explain your issue, and makes it easier for us to help you. Please use the following steps to send us a screen shot.

1) Press the Print Screen button

2) Open your paint program.

3) Go to the Edit menu item, select paste

4) Go to the File menu item, select save image as (.bmp,.gif,.jpg)

5) Attach the image to your email, send it to support@mdansby.com
User Reference Manuals

Click here for the 4D User Reference Manual
Click here for the 4D Write User Reference Manual
Login Process: (The Adminstrator password is admin)
The Login process is optional, you can activate the login process in the Preferences area.
To start the Landlord Report application, just double-click on the Landlord Report application.

Once the application has been started, you will see a password dialog window.
Select user to login as, then enter the password and press "OK".

As an administrator you can create and edit users. The default administration password is "admin".

Once you login, click on the Preferences icon on the palette. In the Preferences area you can add the owners information.
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If you have any questions, please contact support@mdansby.com
You can delete the sample information by pressing the delete button on the bottom of the screen. For  example, go to the Tenants area, double-click on a Tenant, and at the bottom you will find the delete button.

Landlord Report Desktop: Properties Module (List Screen)
After you double-click on the Properties icon, a list of properties is shown.

Below in the screen shot. There is one property in the list.
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To see the detailed property information, just double-click on the property (Double-click selection to open) and the detail screen will appear.

Done - closes the window. 

All Records - displays all records.

New Property - creates a new unit to track.

Search - allows you to query information in the property area.

Sort - allows you to sort information, based on the criteria you set.

Labels - allows you to create mailing labels.

Quick Report - allows you to generate reports, based on the information saved in this module.

Landlord Report Desktop: Properties Module (Detail Screen)
The detail screen displays the property information for the building.

The property information allows you to track the following; condition, description, legal description,

invested, additional photos, insurance, units and utilities.

Just click on the tab to view the information under tab heading.

Cancel - closs the detail window and reverts back to the List screen. 
Save - saves the information.

"<" - previous record

">" - next record

Landlord Report Desktop: Tenant Module (List Screen)
After you double-click on the Tenant icon, a list of tenants are shown.

Below in the screen shot there are two tenants in the list.
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To see the detailed tenant information, just double-click on the tenant (Double-click selection to open) and the detail screen will appear.
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Done - closes the window.

All Records - displays all records.

New Tenant - creates a new unit to track.

Search - allows you to query information in the tenant area.

Sort - allows you to sort information, based on the critia you set.

Labels - allows you to create mailing labels.

Quick Report - allows you to generate reports, based on the information saved in this module.

ABC's Letters - allows you to quickly search by the first character in the last name.

Landlord Report Desktop: Tenant Module (Detail Screen)
The detail screen displays the tenant information for the building.

The tenant information allows you to track the following Payments, Telephone, Email, Employment, References, Family, Vehicle, Actions, and Notices.
Just click on the tab to view the information under tab heading.

Cancel - closed the detail window and reverts back to the List screen.

Save - saves the information.

Delete - delete record

"<" - previous record

">" - next record

Print Statement - print the complete statement of charges and payment for the tenant.
Quick Letter - allows you to create and edit letters to tenants.
On the Legal Actions tab you can create and edit custom forms and agreement for your tenants.
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Once you double-click on the Form Name, it will take you to a word processing area to create or edit the form.

On the Actions tab you can log all correspondence with the Tenant, such as notices, agreements and court actions.

The following screen shot shows the Photos tab.
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On the Photos 1 -2 -3, you can import images or pictures from a file.

The Landlord Report will be able to handle the following image types: pic, pct, jpeg, gif, tiff, bit, png, bmp, psd, tga, pntg, tpic and bps. Download the free QuickTime player, this plug-in will help process more types of images. http://www.apple.com/quicktime/download/ If you are using a digital camera, just reduce the image size to reduce the image size. Images should not be larger than 100K.

Landlord Report Desktop: Messages Module (List Screen)
After you double-click on the Messages icon, a list of messages are shown.

Below in the screen shot there is one message in the list.
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To see the detailed message information, just double-click on the message (Double-click selection to open) and the detail screen will appear.

Done - closes the window.

All Records - displays all records. 

New Tenant - creates a new message to track.

Search - allows you to query information in the message area.

Sort - allows you to sort information, based on the criteria you set.

Labels - allows you to create mailing labels.

Quick Report - allows you to generate reports, based on the information saved in this module.
Landlord Report Desktop: Message Module (Detail Screen)
The detail screen displays the Message information for our operation.

The Message information allows you to track the following messages, Telephone,Date, Time, Taken By, and Status,

Cancel - closed the detail window and reverts back to the List screen.

Save - saves the information.

"<" - prevoius record

">" - next record

Delete - delete record. 

Landlord Report Desktop: Finance Module (Detail Screen)
The detail screen displays the Finance information for our operation.

The Finance information allows you to track the following; bank accounts, deposit amounts and payment/withdrawal amounts.

Cancel - closes the detail window and reverts back to the List screen.

Record - saves the information.

Write Checks - allows you to write a check on the current account.
Set Account Color - allows you to set color to the account to indentify them differently.
New Account - create a new account to track (Saving, Checking, Cash or Credit)

Delete Account - delete account and all the transactions related to it.
Print Register - print a complete register or transaction of the current account.
Print Checks - allow you to print checks on this account.

Delete Transaction - delete record transaction.
The Agreement Icons allows you to quickly view and edit custom notices, forms and agreements.

Landlord Report Desktop: Preferences Module (Detail Screen)
Save your company or organization information and setting in the preferences

Day Notice - allows you to customized the day on the notices.

Palette on the Right - allow you automatic set the palette to appear on the right.

Currency - Set the currency standard.
Logo - allows you to save your logo for it can appear on printed reports.

Edit Users - allows you to add and edit users to the application.

PopUp List - allows you to maintain a list of items that will appear in popup list in the application.

Registration - allows you to register the application.

You can setup automatic Tenant charges here.

If the Rent is checked, then the application will automatically post the rent charge every month for all of your Tenants with a status of renting or leasing.

Day Interval Tenant also will be charged accordingly.

